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Preface
Version 16 is the Windows version of the T-TEC program for data loggers and 
contains improvements over the former versions.

It supports data loggers types: T-TEC, T-TEC RF, and units with serial numbers 
starting with A, B, C, E, F, G, H, Y, P, Q and V.

This software also supports the iButton data logger models DS1921, DS1922 and 
DS1923. DS1921, DS1922 and DS1923 are trademarks of Maxim Integrated.

We would like to thank our customers for their proposed improvements to the 
program. These suggestions have been most helpful and have been implemented as 
far as possible.

Any further suggestions to improve the program will be most welcome. 

This manual contains instructions for installation and configuration of the 
T-TEC program and some notes and examples for the use of the program. There 
is no detailed description of the functions in the printed manual as the program 
contains an extensive ‘Help’ file with all details. This manual is also on the 
supplied CD and is downloadable from our website. The help file also contains a 
small tutorial, on basic functions.

Any new information not available at the printing of this manual is included in a 
text file, ‘Readme.txt’, on the supplied CD.

Version 16 is confirmed to work with Windows 10 and Windows 11. 
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Warranty
Your T-TEC data logger is guaranteed against any defects in materials and 
workmanship for a period of one year from the date of the original purchase of 
the data logger from the distributor. In this period, any part will be replaced or 
repaired at our discretion if proved to be defective, free of charge.

This warranty does not cover accidental damage, misuse, negligence, shipping or 
any alteration whatsoever in the form or content of the data logger. 

Data loggers to be serviced must be handed to the distributor or shipped carefully 
packed in a suitable container to the distributor or to Temperature Technology. We 
are not responsible for freight charges or losses in transit.

Liabilities
ALL PRODUCT, PRODUCT SPECIFICATIONS AND DATA ARE SUBJECT TO 
CHANGE WITHOUT NOTICE TO IMPROVE RELIABILITY, FUNCTION OR 
DESIGN OR OTHERWISE. 

Nordex Pty Ltd, trading as ‘Temperature Technology’, its affiliates, agents, and 
employees, and all persons acting on its or their behalf (collectively, “Temperature 
Technology”), disclaim any and all liability for any errors, inaccuracies or 
incompleteness contained in any data set or in any other disclosure relating to any 
product.

Temperature Technology makes no warranty, representation or guarantee 
regarding the suitability of the products for any particular purpose or the 
continuing production of any product. To the maximum extent permitted by 
applicable law, Temperature Technology disclaims (i) any and all liability arising 
out of the application or use of any product, (ii) any and all liability, including 
without limitation special, consequential or incidental damages, and (iii) any and 
all implied warranties, including warranties of fitness for particular purpose, non-
infringement and merchantability. 

Statements regarding the suitability of products for certain types of applications 
are based on Temperature Technology’s knowledge of typical requirements that 
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are often placed on Temperature Technology products in generic applications. 
Such statements are not binding statements about the suitability of products 
for a particular application. It is the customer’s responsibility to validate that a 
particular product with the properties described in the product specification is 
suitable for use in a particular application. Parameters provided in datasheets 
and/or specifications may vary in different applications and performance 
may vary over time. All operating parameters, including typical parameters, 
must be validated for each customer application by the customer’s technical 
experts. Product specifications do not expand or otherwise modify Temperature 
Technology’s terms and conditions of purchase, including but not limited to the 
warranty expressed therein.

Except as expressly indicated in writing, Temperature Technology products are 
not designed for use in medical, life-saving, or life-sustaining applications or for 
any other application in which the failure of the Temperature Technology product 
could result in personal injury or death. Customers using or selling Temperature 
Technology products not expressly indicated for use in such applications do so 
at their own risk. Please contact authorized Temperature Technology personnel 
to obtain written terms and conditions regarding products designed for such 
applications.

No license, express or implied, by estoppel or otherwise, to any intellectual 
property rights is granted by this document or by any conduct of Temperature 
Technology. Product names and markings noted herein may be trademarks of 
their respective owners.
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About data loggers
Data loggers are stand-alone units for the measure and recording of temperature, 
and related physical qualities.

A data logger contains a measuring circuit to measure the value from a sensor, a 
microprocessor to convert the measurements to numerical data and a memory to 
store the measurement.

A data logger is set-up with a T-TEC software installation on a computer and the 
interval between recording of measurements is selected by the user. 

A logger can be set to either collect data until the memory is full and then stop, 
keeping all data, or it may be set to use ‘Wrap Around’ where it will overwrite the 
oldest data while continuing to collect data.

The logger is then placed into position and will work as a stand alone unit, 
measuring with the set interval and storing the collected data. 

The logger can be re-connected to the computer and the collected measurements 
read from the logger to the computer where they may be displayed. A RF logger 
connects wirelessly via the Gateway. 

Both the interface cable and the Gateway contain electronics which make it 
possible for a standard PC to communicate with the T-TEC logger and read the 
data stored in the data logger’s memory. 

Multiple loggers can work together
Sometimes one logger may tell what happened and another may tell why it 
happened.

Example Ex2-2 in chapter ‘Graph Viewer’, shows results from two loggers working 
together. One logger is placed with the goods and another logger is placed to read 
the ambient temperature.
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The first logger shows the temperature of the goods, the second shows why the 
temperature of the goods varied.

Graph Viewer can show up to eight graphs at the same time. When calendar time 
is selected as the time scale, all loggers show what happened at the same time - 
six o’clock for one logger is also six o’clock for the other loggers. The loggers will 
then work together as a multichannel logger. There is no need to interconnect the 
loggers. Neither do the loggers need to be started at precisely the same time, as 
long as the measurements overlap in time. The computer synchronises all graphs 
to the computer’s clock at the time of start of the loggers with a tolerance of ± 1 
second.

Erasure of data in memory
When the data logger starts a new measuring cycle, the microprocessor in the 
logger resets all references to the existing data in the memory and the old data 
cannot be recovered. The new data then simply overwrites the old.
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Information for IT staff
Installing
Please be aware that installation does involve the installation of drivers which are 
necessary for the successful operation of the relevant devices. Installation does 
require administrator access for the successful installation of the drivers. If you 
are required to perform the installation, we strongly advise your presence on site, 
as the process involves hardware that may need to be plugged in and out.

Driver problem
Sometimes drivers don’t install as expected. If you are having trouble running 
the software, check the drivers. Open up ‘Device Manager’ and have a look for 
anything with a yellow exclamation mark. If present, unplug the device from the 
computer and see if that entry in ‘Device Manager’ consequently disappears. If 
so, re-plug the device in and see if the driver can be re-installed. Most drivers 
are copied to C:\T-TECW and can be found there. Sometimes it helps to turn the 
computer off and back on again. If you don’t know how to update a driver, please 
call, we’ll talk you through it.

The drivers can be found in these folders:

1. iButton drivers can found in the WinUSB_Driver
2. T-TEC Gateway drivers can be found in the T-TEC_GATEWAY_DRIVER
3. Older USB drivers can be found in T-TEC_USB_DRIVER

Software key
The software requires a licence to operate Graph Viewer more than ten times, or 
for TempReport to operate at all. If the software version number that was installed 
includes a ‘K’, then the key is already installed. If a key is needed, please email 
sales@t-tec.com.au, and include with your request what name you would like the 
software registered to.
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Downloading
Please be aware that these devices create files that need to be downloaded to the 
computer, normally C:\T-TECW. Users will need permissions to download to the 
computer from these external devices.

Battery change
Devices will need their batteries changed on a regular basis. Each device has a 
relevant chapter that describes this process.

Installing/using a T-TEC WiFi Gateway in TempReport
These instructions are for installing and using a T-TEC WiFi Gateway that can be 
accessed via the local area network (LAN) and thus does not need to be directly 
connected to a computer.

How to connect a T-TEC W-USB WiFi Gateway to your network
1.	 Connect your Gateway to your computer via a USB port.
2.	 Open TempReport, and find the drop down list for the Gateway at the bottom 

of the main screen. Select ‘USB Gateway’.  It should have a green dot next 
to it. If, after waiting 10 seconds, it does not have a green dot, please contact 
Temperature Technology.

3.	 Go to ‘Check Gateway’. If you have not yet registered the Gateway in 
TempReport, press ‘Register gateway’. Give the Gateway a relevant name.

4.	 In the ‘WiFi’ tab, please enter the details for your wireless LAN, and press 
‘Submit’.

5.	 Press ‘Close’.
6.	 At this stage, you can install the Gateway to the desired location. 

How to connect a T-TEC W-USB WiFi Gateway to a cloud
1.	 Connect your Gateway to your computer via a USB port.
2.	 Open TempReport, and find the drop down list for the Gateway at the bottom 

of the main screen. Select ‘USB Gateway’.  It should have a green dot next 
to it. If, after waiting 10 seconds, it does not have a green dot, please contact 
Temperature Technology. 
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3.	 Go to ‘Check Gateway’. If you have not yet registered the Gateway in 
TempReport, press ‘Register gateway’. Give the Gateway a relevant name.

4.	 In the ‘Cloud’ tab, please enter the details for your cloud (normally cloud.
tempreport.com.au) and press ‘Apply settings’.

5.	 Press ‘Close’.
6.	 At this stage, you can install the Gateway to the desired location. 

Installing a Gateway in TempReport 
These instructions are for Gateways not yet registered to TempReport. The 
instructions above already include registration. Once registered, Gateways are 
available over the LAN or cloud.

1.	 In TempReport, go to ‘Settings’ > ‘Gateway Management’ and press ‘Add’.
2.	 In ‘Enter Gateway MAC address’, enter the MAC address.
3.	 In ‘Enter Gateway name’, please give the Gateway a name you like and can 

remember, and enter it into this field.
4.	 Please leave the last field as ‘Autodetect’ and press ‘Confirm’. 
5.	 Then press ‘Close’

Using the WiFi Gateway in TempReport
Once the instructions for ‘How to connect a T-TEC W-USB WiFi Gateway to your 
network’ or ‘Telling TempReport the details of the Gateway’, and the Gateway has 
been installed in the desired location that is within reach of the wireless LAN, 
then you should be able to select that Gateway in the main screen of TempReport.

1.	 Open TempReport (if not already open)
2.	 In the main screen, click on the drop down list for the Gateways, at the bottom 

of the screen on the information- or right-hand -side. 
3.	 If all is working as it should, then an entry should appear with a green dot with 

the name that was given to the Gateway, with the prefix (LAN).
4.	 Select that Gateway to be able to receive data from it. 
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Installing/using a T-TEC WiFi Gateway in the mobile app
These instructions are for installing and using a T-TEC WiFi Gateway, via an app, 
that can be accessed via the local area network (LAN) and thus does not need to 
be directly connected to a computer.

Install the app
First, install the app. Go to either Google Play Console or Apple App Store and 
look for TempReport by Temperature Technology. Pay the nominal cost and 
download and install the software.

Installing a Gateway in the mobile app
Open the app and the first screen should appear as below. On the top right hand 
side there are three small horizontal lines (a navigational hamburger), clicking that 
should produce a navigational element on the screen. Choose the option that says 
‘Gateways’ and a screen as below appears.

Figure 1. From left to right, the first screen upon installing the software, the 
navigational part of the app, and the Gateways area. 
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Press the ‘+’ sign at the top right of the Gateways screen and another new screen 
should appear. Add the MAC address of the Gateway and press ‘Add’. Use the ‘<’ 
key to remove any additions, Once ‘Add’is pressed, the app reverts back to the 
‘Gateways’ screen and now the Gateway is listed. 

Figure 2. Add New Gateway screen of the mobile app., and the new Gateway listed 
and the Gateway info screen.
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How to connect a T-TEC W-USB WiFi Gateway to your network in the app
In ‘Gateways’, click on the Gateway to connect and the Gateway Info screen will 
appear. In that screen, click ‘Connect to WiFi’. A new screen comes up with a 
text field for the SSID (name) of the network and the password. There is also an 
optional field for the address of the cloud. Enter the selected details and press 
apply. 

Using a previously set up WiFi Gateway in TempReport
Open up TempReport, and press New Logger. Add the serial number of the logger 
to the field and press OK. Wait a few minutes until the synchronisation is complete 
and the unit should now be accessible.

Accessing data via mobile phone apps
There are apps in both the Google Play Store (at a nominal cost of $1) and 
the Apple Store (at no cost). These apps will allow you to follow the current 
temperatures and small graphs of the last three days from  your data loggers on 
your mobile phones.
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In case of an alarm, the phone can receive an alert and the line for the logger turns 
red. The phone can only receive the updates. To access the loggers, you need to run 
TempReport on a PC/laptop. 

For the alerts to work your loggers must have enabled automatic updates at 
maximum 1 hour internvals and alarms if required. and your gateway must have 
access to the TempReport cloud at all times. The Gateway must be connected to 
power (5V) and in contact with WiFI for 24 hour updates and alarm notifications.

When you have downloaded the app, type in your cloud key, install the gateway 
and name it if you have more than one gateway and add your loggers. They can 
also be named. 

Gateway attached directly to a computer
The Gateway should have a powered port so that it can wake the computer up if it 
receives an alarm. See the section ‘Wake up’ on page 12.

A way of extending the distance between the data logger and the PC can be to 
plug the Gateway into a USB sharing server that is connected to your LAN. These 
devices are sold with their own software, please follow their guides for installation 
of these devices. This method can mean that the distance between the data loggers 
and the Gateway can fit requirements and the computer that connects the USB 
sharing server can be far away from the computer.
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T-TEC Gateway with relay output
Relay output is an optional extra on the gateway. The relay is a change-over 
type. Max 1A 30V DC/ 0.5A 125V AC resistive load. Gold plated silver contacts. 
Expected life at 1A 30V DC resistive load: 20,000 operations.

The T-TEC Gateway with relay output can be used with a normally open or 
normally closed circuit. In case of alarm the relay changes over. The gateway 
comes complete with green Phoenix™ connector for the alarm contact. The 
connector has two parts. The male part of the connector can be detached. It can 
connect the 3 wires necessary to connect to a building alarm system, a dialler or 
other alert system. After connecting the wires, the male connector may be securely 
screwed into the gateway.

Normally open A, B will close contact when alarm arrives. Normally closed B, C 
will open contact when alarm arrives. Current relay behaviour is normally off.

Please contact the factory for a Gateway with opposite relay behaviour.

Temperature Technology
Gateway WUSB-03

A B C

The gateway has no power in itself; it requires an external power source to operate. 
When the PC is on, the USB port provides sufficient power for the gateway. If 
your computer is able and set up to do so, it can provide power via USB while the 
computer is off. This may require changing settings on the motherboard — most 
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modern motherboards have this capacity which may be switched off for power 
management and/or efficiency reasons. Please see your IT administrator for this. 
When the PC does not provide power, or when the Gateway is not connected to a 
PC, auxiliary power is needed. This can be provided by a power source of 5VDC 
(max 6.5VDC), 100mA. A connector cable for power supply is available from 
Temperature Technology. A mini USB cable to a USB wall charger is sufficient.

Specific to-TEC RF
For outgoing alarm messages via server or cloud, please see page SMS setup on 
page 29 in TempReport and cloud subscription service in TempReport on page 
31.

For manual data backups, see page 32.

MQTT
Please see page 33 for information relating to MQTT and exporting data to 
other systems.
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Installation
When you have purchased your software, please fill out and return the registration 
form to receive your key by return email. In some cases, the key file has already 
been incorporated into the CD and the CD will be marked with an additional ‘K’. 
To receive your software key, please provide the serial number of the software and 
the name you would like the software licensed to and we will forward a key to you.

The key is a small file which should be copied to the same directory where the 
T-TECW program resides.

Version 16 is supplied on a CD with an installation program to make the 
installation easier. The CD also has a copy of this manual in PDF.

Upgrades
When you have your licence key, you can upgrade the software to a new version. 
Please log on to our website to download and install the new version over your 
existing program to update it. Logger and key files are preserved during this 
process.

The user can choose to install programs to support one or more of the devices. We 
recommend to install all programs.
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Installing the T-TEC Software
Please close all other programs first.

Do not connect cables to your computer yet.

It is possible to install the software either from the supplied CD or from a 
download via the website (www.t-tec.com.au) . Installing from the download from 
the website begins from the ‘Install Now’ section below, after double clicking on 
the file to run it.

Installation is divided into three parts: Installation of software, installation of 
necessary drivers and configuring of the programs.

The installation program will work for Win XP/VISTA/7/8/10.

Installing from CD
When the CD is inserted, the CD will 
produce a window similar to the one on the 
right, and will highlight ‘Run SetupT.exe’. 
Click on ‘Run SetupT.exe’.

If the dialog box does not appear, go to 
‘Start’. Click ‘Computer’ in the right field. 
Select DVD/CD drive and double click on 
the program, ‘SetupT.exe’.

This will install the software — please continue to ‘Install Now’ later in this 
section.

If a dialog box titled ‘User Account Control’ appears that asks you, “Do you want 
to allow the following program from an unknown publisher to make changes to 
this computer? Program name: SetupT.exe”, click on ‘Yes’.
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Install Now
Installation starts with a 
Welcome screen.

Select Destination
Choose Drive to install 
the program in: 

Click ‘Next’.

The default is the C Drive.

Click ‘Next’.
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You will need:

The T-TEC Graph 
viewer
The Device drivers

and at least one 
of the following 
communications 
programs: 

T-TEC Logger communications
T-TEC RF Logger communications
iButton communications
TempTec-R Reader communications

It is easiest to just install them all.

 
Start menu folder

Select components
The T-TEC program has 5 
components.

Click ‘Next’.
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Additional tasks
Select icons for your desk 
top. Icons you will need: 

T-TECW Graph Viewer. 
From there you can 
access both iButton 
and T-TEC data logger 
communications 
programs.

If you have the TempTec 
Reader, you will need the 
icon for it. 

If you have wireless data loggers, you will need the icon for TempReport also.

We recommend staying with the default, where all options are checked.

Ready to install
Click: ‘Install’ if you are 
happy with your choices 
or ‘Back’ if you want to 
change something.
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Device Driver Installation
Device Driver 
Installation Wizard 
will appear each time 
to install the drivers for 
the new USB cable, the 
older USB cables and 
the iButton drivers. 

USB Gateway 06
The T-TEC USB Gateway 
06 is a new cable, 
replacing the T-TEC USB 
02 cable. It looks very 
similar but needs a new 
version of software to 
operate.

Should you have this cable and wish to install it, you will need to plug in the cable 
at this point and click ‘Yes’. This options only appears for Windows 7 and older.

If you have already installed this driver or don’t have this cable, you do not need to 
install and so may click ‘No’.

WUSB-03 installation
If you are installing the larger gateway (WUSB-03) for the wireless loggers and are 
running Windows 7 or older, please choose ‘yes’ for this option. 

Click ‘Next’
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For cables other than the T-TEC USB Gateway 6, please connect the interface 
adaptor to the computer now and the device to the interface cable. If you want 
to install for more than one device, then connect one device at a time and follow 
prompts as above.

Device Driver Installation Completion
This dialog box appears 
each time one of the 
drivers has finished 
installing.

Click ‘Finish’.

Completing set-up

Click: ‘Finish’
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Installation of USB driver for T-TEC USB 02 and older T-TEC USB 06
For or Win XP through to Windows 7, the driver is installed with the software. For 
later operating systems, connect the cable and the logger/reader to an USB port on 
the computer. The Windows system will detect the adaptor and either install the 
drivers automatically or start the ‘Add New Hardware Wizard’. 

If asked if you want to connect to Windows update, tick ‘No’.

Click ‘Next’ to continue.

The PC will ask you ‘What do you want Windows to do?’

Please select ‘Search for the best driver for your device’. For WinXP and newer 
versions, the driver is now found automatically.

Click ‘Next’ and the driver will be installed. 

In case of errors
If needed, simply re-install the program(s). There is no need to un-install anything 
before re-installing.
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Compare your datalogger to these images, and go to the chapter that best looks 
like your datalogger.

T-
TE

C
 7

T-
TE

C
 6

T-
TE

C
 6

T-
TE

C
 7

USB

Power

Graph Sensor Long press
Min/max reset

Long press
Mute alarm

ttTempTec 816

T-TEC RF	 page 10 

T-TEC logger 	 page 39

iButton logge	 page 52

TempTec 816	 page 59

Graph Viewer software	 page 61	
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T-TEC RF
If your logger looks like below, then read this section. Otherwise, please find the 
chapter that has a picture that looks like your data logger, listed on page 9.

T-
TE

C
 6

T-
TE

C
 7
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Gateway Setup
Please see “Installing/using a T-TEC WiFi Gateway in TempReport” on page xiv 
to set up a gateway for LAN, internet and cloud access. 

To start the program
To start the program, double click on the icon for TempReport.

TempReport program is the communications program for the T-TEC RF 
wireless data loggers. For more information, see the online help.

T-TEC RF Gateway (WUSB-03)
For systems running Windows 7 or older, the drivers can be pre-installed during 
installation. For systems running Windows 8 and above, the drivers are pre-loaded 
onto the device and will install directly.

In case of errors
If needed, simply re-install the program(s). There is no need to un-install anything 
before re-installing.

Screenshot of main screen of TempReport, which is divided into sections: a top half 
for system administration with a list of all data loggers in the system and their 
current status, and a bottom half for specific logger information and operation.
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Wake up
The Gateway has a wake up function that can wake the computer from standby or 
sleep when an alarm is triggered. The computer can then send emails and SMSes, 
and automatically download the logger. If cloud access is enabled, then the data 
will be transferred to the cloud after a few minutes . Once transferred, the data can 
be seen on computers with the T-TEC TempReport system and access to the data.

To allow the Gateway to wake the computer, the ‘USB Wake up’ feature in the 
computer’s BIOS needs to be enabled. Please seek help from your IT support team. 
For most, this is enabled by default. Check that the motherboard supports standby 
voltage on the USB bus. It may need a jumper. Not all USB ports may support this 
feature. Please try different ports. A good way to test the standby voltage is with 
a half-charged mobile phone. If the phone charges from the USB port while the 
computer is sleeping, it has standby voltage. If not, try another port, either on the 
front or back of the computer.

To test the wake up capability, set up an alarm in a logger, eg. a maximum alarm 
below the current measured value. Set minimum grace time to two minutes. 
Put the computer to sleep by clicking ‘Start’ in lower left corner, and then either 
clicking ‘Sleep’ or ‘Stand by’. The gateway should wake the computer in two 
minutes.

Otherwise, the computer either must not sleep or be able to automatically logon 
again after sleep.

To automatically logon after sleep: the operating system feature, ‘Prompt for 
password when computer resumes from standby’ needs to be deselected:

Windows 7 and Windows 10
‘Start’ > ‘Control Panel’ > ‘Power options’ > ‘Require a password on wakeup’ > 
‘Change settings that are currently unavailable‘> ‘Don’t require a password’ > ‘Save 
Settings’
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Windows XP
‘Start’ > ‘Control Panel’ > ‘Power Options’ > ‘Advanced’ > Untick: ‘Prompt for 
password when computer resumes from standby’
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Operating a T-TEC RF data logger
This section assumes that you have installed the software (see the section on 
installation on page 1), have a T-TEC RF data logger and a WUSB-03 Gateway, 
which is connected to the computer. For more indepth instruction for the software  
(such as grouping of data loggers) please see the online help file by pressing F1.

Communication with the data logger
To communicate with a T-TEC RF data logger, it must first be registered into the 
system via ‘Add new logger’.

Add new logger
To add a logger into the system, click ‘Add New Logger’ in the main screen.

When the dialog box appears, type in the data logger’s serial number. The serial 
number can be found on the label on the back of the data logger. The serial 
number does not include the type letter. For example, if the data logger is a ‘T-TEC 
6-1C12345’, the serial number is ‘12345’.

When the serial number is entered and ‘Register’ is clicked, a dialog then asks, 
‘Do you wish to synchronise the logger?’ The software is asking to be allowed to 
communicate with the data logger to download some details about it. If you say no 
at this time, it can be performed later. All that is needed is to highlight the logger 
in question and press the button, ‘Refresh this logger only’ found in the right hand 
corner. Once the process is complete, the main screen is displayed.

Once a logger is entered, the logger can be read or started.

To start the T-TEC RF data logger
In the main screen, click on the data logger you wish to start. It will then be 
highlighted. Then, in the list of buttons to the left, find the button labeled, ‘Start 
logger’. Click on ‘Start logger’. A dialog box with various options will appear.

Sensor interval
Each sensor can have a different interval, so each sensor is individually listed along 
with what type of sensor it is.
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Choose how often you want to log (or record) the physical property (eg. 
temperature, humidity, etc). Please see the later sections on file compression and 
logging duration on page 25.

Delay start
Do you want to start the logger immediately, or do you want the device to 
start recording at a later time? If you would like the device to record at a later 
time, check ‘Delay start’ and choose the time you would like the device to start 
recording. This can be useful if you know the exact times you would like recorded. 
This can be useful if you have set alarms in the data logger but don’t want them 
activated until the logger is placed into position.

Wrap around
The next choice, ‘Wrap around’, is about what you would like to happen once 
the memory is full. Do you want the data logger to ‘wrap around’ back to the 
beginning, replacing the oldest values with new measurements? If it is the former, 
check this option, otherwise leave it unchecked and the logger will stop when the 
memory is full.

Comments
There is an area that allows you to type your own comments. These can be used to 
help you remember settings, locations, test batches, etc. They can be anything and 
are not used by the software. This field is limited to 120 characters.

Location/Name
Location/Name is similar to a comment field but is used by the software. For 
identification purposes in the main screen, it is a good idea to give the data logger 
a location or name identifier, so you can quickly tell the difference between 
multiple loggers in the list. It is much easier to differentiate betwen ‘Peter’s Desk’ 
and ‘Joe’s Desk’ as opposed to ‘C-102345’ and ‘C-102346’ in a list. This field is 
especially important if importing the data into DyMap. Please see the help for 
Dymap (not in this manual).
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Start the logger
Once the setup is as desired, click on the button ‘Start logger’. A confirmation 
dialog box will appear, asking if you want to start the specific logger. Check that 
it is the correct logger you are starting. If you are still happy with the setup, then 
click ‘Yes’. If not, then click ‘No’ and repeat the procedure until you have set up the 
correct logger with the correct configuration.

The logger can be set up for ‘Automatic downloads’ or you can manually 
‘Download’ the data once enough data points have been recorded (3 logs).

To read the T-TEC RF data logger
When a wireless T-TEC logger has been started, the system is ready to return data. 
Note that at least three logs are needed to create a graph, but the current data (even 
less than three logs) is still available for viewing in TempReport via ‘Data updates’ 
on the main screen.

Download logger
Highlight the data logger you wish to download by clicking on it in the data logger 
list in the main screen. Then press the button, ‘Download data’. If the data logger 
can be contacted, new data will be downloaded and stored in the computer. All the 
data from the current mission (operation) will be sent to and displayed in ‘Graph 
Viewer’.

In ‘Graph Viewer’, the data can be analysed statistically and exported to formats 
that spreadsheets can import. For more information, see ‘Graph Viewer’ on page 
61 

Downloading and viewing the data is the best way to see what happened after an 
alarm that has been set up via ‘Change alarms’ has occurred.

View logs
To access data not included in the current set, click on, ‘View logs’. This allows you 
to see the recording start date, the date of the last measurement, and the name 
or location of the data logger of that data set. Sometimes, the record is split into 
multiple parts due to missing measurements when a logger is set to ‘Wrap around’. 
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This becomes apparent when a data set of recordings is selected and ‘Open selected 
logs’ is chosen. If the log is split into various parts, the software will produce a 
numerical list of the parts with an option to choose which section.

Export data
Data can be exported from TempReport by selecting the format you want to 
export to, and then pressing the ‘Export’ button.

Data updates
The software can request and receive updates from the data loggers at user-set 
intervals. Those updates are the current value from the sensor (eg. temperature) 
and current status of the specified data logger in the main screen of TempReport. 
To enable this feature and set the interval time, choose ‘Data updates’ in the main 
screen and check ‘Enable automatic reports’. Go to ‘Update every’ and set the 
interval. 

The software can also quietly and seamlessly download data from the data logger 
in the background, reducing the amount of time required to download the data 
logger as well as reducing the burden on the battery. The three options for this are: 

Periodic
Periodic downloads happen at set user-timed intervals, to set a maximum of time 
for new data to accrue. The intervals range between 30 minutes and 24 hours. 

Scheduled
This option allows the time of download to be scheduled. This can be useful if, for 
example, the data loggers are in the back of trucks carrying loads, but return to 
the yard at the end of the day. The download can be scheduled to happen at a time 
when the data logger will be in range. If the scheduled download doesn’t occur (eg. 
the computer was turned off) the download will happen when possible.

Background
Using this setting downloads happen regularly, preventing a build-up of 
undownloaded data.
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Please note, data updates and downloads can only occur when the computer is 
running and can contact the data logger through the Gateway. 

Logger Security
Data loggers can be quite mobile, and there could be many times when data 
loggers come into the range of other TTEC Gateways that may or may not be your 
own. ‘Logger security’, also known as ‘User access control’, is about what should 
happen when that occurs. There could be times when you want to prevent all 
access, and other times when you want to share some data. 

Logger security is deciding who, how, what and when others can have access to 
your various devices, including Gateways. You will need to ask yourself all sorts of 
different questions. Examples of these are:

Who do you want to access your devices? Within your organisation? Outside of it? 
How do you want them to access it? Via a Gateway? Or only the data via software? 
What functions of the data logger do you want them to access? Should they be able 
to change or stop the alarms? 

Terminology
‘Registering’ 
is when a user adds a data logger to their list of data loggers in TempReport 

Domain 
When Logger Security is changed, the software will stamp the logger with your 
domain (based on your registration key) depending on your settings. Since 
domain is based on the registration key, then the registration key needs to be 
shared to also share the domain.

Dataloggers can be registered without being stamped with a domain but the risk 
is that a datalogger that has not been stamped with a domain can be stamped by 
anyone at anytime, when registering that data logger into their software, if they 
can communicate to the logger. This means potentially someone could secure the 
logger, and prevent you from accessing it.
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To create or modify logger security, highlight the chosen data logger in the main 

screen, and press ‘Logger security’. This brings up a dialog box that is essentially in 
two halves: Domains and passwords. 

The logger security dialog 
Domains are split into two: home domain and other domains. Home domain is 
your own domain based on your software registration key. Other domains have a 
different software registration key. 

There are four password fields, one of which is a master. The master password must 
be set if the access to the home domain is other than the default full access. This is 
to prevent you from disabling your own access to your own device.

Home domain
The default setting is ‘Full Access’, where all Gateways that belong to your domain 
can access all features. This can be changed to ‘Read Only’ or ‘Custom’ where 
the permissions for various features can be set individually. Either of these two 
choices mean that a master password that has full access must be set. In order to 
determine domain, a domain must be stamped aboard the logger by the software. 
This happens seamlessly and quietly when you change the security settings. 

If you change your own domain access to ‘Read-only’, it means other devices that 
belong to your domain can only read the device. The computer where the master 
password was set and stored has full access.
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If you change your own domain access to ‘Custom’ that means that other devices 
within your domain will only have the permissions that you give them. As per 
‘Read-only’, you will have full access with a master-password.

Other domains
The default factory setting allows access from other domains.

Other domains belong to other people or organisations who may also have TTEC 
Gateways. You can set which, if any, features you would like them to have access 
to. It may be that you do not want them to have any access; it may be that you 
deliberately want them to have read only or custom level of access.

Allowing access to other domains could be useful in some cases, for example, 
data loggers can be in the back of trucks, and once the truck with the data logger 
in the back has arrived at the receiver’s yard, the receiver’s gateway can find and 
communicate to the data logger, downloading the temperature straight to their 
computer.

Other options available for other domains include ‘no access’ where devices from 
other domains have no access to your device, and ‘full access’ where devices from 
other domains have full access and rights to your devices (they can start and stop 
data loggers, change alarms, and settings).‘Read only’: means other domains can 
read the data from your logger, but are unable to control it or give it commands; 
and ‘Custom’, so that other people or organisations using a different domain only 
have the permissions that you have set them.

Passwords
There also can be other situations present where you would want some people or 
organisations to have different access settings to the set domain level. This can be 
set with passwords. 

The software can have up to four passwords, one of which is a master password, 
used when the access for your own network/domain is changed from the default. 
Each of the other three passwords can have their own set of permissions for access 
to data logger features.
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Keys
Keys are passwords that have been encapsulated with other data, such as time 
limitation, and then encrypted for safe transfer. 

To generate a key, go to ‘Logger security’ as described previously, and click the 
button ‘Generate new key’. In the dialog box, enter which data logger you wish to 
create a key for, the type of device it is and the password you want to turn into a 

key. The key is generated in the text field at the bottom. Click and drag to highlight 
key. Press ‘Ctrl’ + ‘C’ to copy it to the clipboard. In your email program, either 
choose ‘Edit’ > ‘Paste’ or press ‘Ctrl’ + ‘V’ to paste the key, so it can be sent to your 
chosen recipient. 

Password and key management
Passwords and keys are stored and managed in the ‘Local passwords’ section of the 
‘Settings’ dialog box.

Setting logger security permissions
Settings permissions for actions
Clicking the button with the three small dots brings up the logger security 
permission dialog box. This defines what actions that domain or password 
has access to. The following section explains the security permissions that are 
customisable.

General Read
Checking this option allows others to register and synchronise the data logger in 
their system, receiving information about the data logger and displaying it in the 
main screen only.
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Start logger
This option gives permission to start the logger: recording at a specific time 
interval. This includes the ability to change the comments and the name/location 
field, delay start and wrap around, as per starting a logger. A logger must be first 
stopped before it can be started.

Stop logger
Checking this option gives permission to stop the logger so that it no longer 
records measurements at a set interval. This can be beneficial to extend the life of 
the data logger battery. 

Download logger
Checking this option allows the data on board the logger to be downloaded to 
another computer.

View logs
This allows access to the past records of the data logger. 

Change updates
This option makes ‘Automatic downloads’ and ‘Data updates’ available to the user. 

Stop alarm
Checking this option allows the recipient to stop the alarm on board the logger 
and/or in the software. Stopping an alarm stops the alarm temporarily. Should an 
alarm condition persist beyond the grace period time limit, then the alarm will 
re-signal.

Change alarm
If checked, then the user can change the alarms, either minimum, maximum, 
advanced, value, grace period and communication forms (email, SMS and relay). 
The best way to stop an alarm completely is to remove the alarm through ‘Change 
alarm’.



ttT-TEC User manual

23

Change security
Allow the recipient to change logger security settings (for the home domain, for 
other domains, and to create passwords. Note, that the software cannot see any 
pre-existing password on board the logger, and so will re-write any pre-existing 
passwords on board the logger. 

Defective Sensors
A data logger with a short circuited sensor will record a very high temperature and 
a data logger with an open circuit sensor will record -273 °C. If this occurs, please 
return the unit to the factory for repairs with a note as to what happened.

Alarms
T-TEC RF type 6 and 7 loggers contain an alarm function. Two alarms may be 
set at any time, either as a maximum (alarm if temperature exceeds a set limit) or 
as minimum (alarm if the temperature falls below a set limit), and an individual 
delay time (grace period) may be set for each alarm. Alarms are set by highlighting 
the specific data logger in the main screen and pressing ‘Change alarm’. More 
alarm options are available under the advanced screen of ‘Change alarm’. See the 
online helpfile for more information.

If an alarm is triggered, a T-TEC RF 6 data logger will indicate this with ‘beeps’: 
one beep if alarm 1 has been triggered, two beeps if alarm 2 has been triggered 
and three beeps if both alarms have been triggered. A T-TEC RF 7 data logger will 
show ‘A1’ if alarm 1 has been triggered, ‘A2’ if alarm 2 has been triggered and ‘A12’ 
if both alarms have been triggered.

Alarms will also appear as notifications in the operating system and within the 
software. The data logger(s) in question will be highlighted in red and when 
selected, the information panel will contain information about the alarm status. If 
set to do so, TempReport will also send SMSes and/or emails. Alarms can be set so 
that TempReport will send SMS and/or email when alarm events are triggered
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The beeping or alarm display may be stopped by choosing ‘Stop Alarm’ in the 
menu in the main screen of TempReport, and then ensuring, ‘Stop alarm on 
logger’ is checked, pressing ‘Save’.

The alarm notifications and alarms in software may be stopped by choosing ‘Stop 
Alarm’ in the menu in the Communications Program, and then ensuring, ‘Stop 
alarm in software’ is checked, pressing ‘Save’.

The datalogger can alarm again, after the expiration of a new grace period, if the 
alarm conditions persist. To permanently stop the alarm, it will need to be either 
changed or removed. Choose ‘Change alarm’ and either change the alarm settings 
or uncheck the alarm.

Time of alarm condition accumulates until reset
Normally, an alarm with a grace period would start counting from 0 when an 
alarm condition occurs. The option, ‘Time of alarm condition accumulates until 
reset’ means that the first time an alarm condition is generated, the grace period 
starts counting from zero. Subsequent alarm conditions are treated as an extension 
of the first alarm condition, so that the grace period countdown is continued from 
where it left off last time.

For example, if the grace period is set to 10 minutes and the first alarm condition 
takes up 4 minutes, leaving 6 minutes of grace period left. When the second alarm 
condition continues for more than 6 minutes, then an alarm is generated. Once 
the grace period has expired, in possibly multiple events, an alarm is generated 
immediately, in all subsequent events. 

The alarm time accumulation is reset, so that the grace period is returned. This 
can be customised to times (every hour, 2, 6, 12, 24, 48, 72 hours, 1 or 2 weeks, 1, 
2, 3, 6 or 12 months, or infinitely.

As an example: a freezer with automatic defrost is likely to exceed the maximum 
alarm temperature during the defrost. This is part of the functioning of the freezer 
and should not create an alarm. If the total time over a 24 hour cycle is too long, 
then something may be wrong with the function or operation of the freezer.
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Relay output for T-TEC RF Loggers
Relay output for the RF loggers is an optional extra on the Gateway. All loggers 
can send alarms to the Gateway, which in turn can set the relay. The relay can 
be reset via the software. Once a Gateway is set up, it can be placed into location 
with its own power source for relay purposes. A second Gateway, attached to a 
computer, can be used to change the settings on any number of data loggers at any 
time. Please see ‘Gateway’ under ‘Infomation for IT staff’ on page xx for more 
information.

Data compression
T-TEC RF loggers use data compression for the data in the memory of the logger. 
The memory can then contain a greater number of measurements. The more 
similar the measurements are, the larger number of measurements the logger 
can keep. This is the reason we cannot give a fixed number of data a logger can 
contain. 

For example, the temperature in a commercial freezer may vary from -23°C to 
-20°C, a variation of 3 degrees Celsius. Each cycle (top-to-top) may take around 
one hour. Compared to the logger measuring range of -40 to +70 °C, the variations 
are small, from top to bottom around 3%. The number of stored measurements 
will be less with longer intervals as the temperature will vary more between each 
measurement.

Number of measurements for a logger
The data sheets show the expected minimum number for a specific logger type.

Logging Intervals
See ‘Data compression’ on page 25 for the explanation of the variable amount of 
measurements a data logger can store.

The following table may also be used:
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Logging duration at different intervals 
Interval 3,000 logs 12,000 logs 20,000 logs 100,000 logs‡

 1 sec 50 min 3.3 hours 5.6 hours 27 hours
 2 sec 1.7 hour 6.7 hours 11 hours 2 days
 5 sec 4.2 hours 17 hours 28 hours 5.5 days
 10 sec 8.3 hours 33 hours 2.3 days 11.5 days
15 sec‡ N/A N/A N/A 17 days
 30 sec 25 hours 4.2 days 6.9 days 34 days
 1 min 2.1 days 8.3 days 14 days 69 days
 2 min 4.5 days 17 days 28 days 138 days
 5 min 10 days 42 days 69 days 347 days
 10 min 21 days 83 days 169 days 1.9† years
15 min‡ N/A N/A N/A 2.5† years
 30 min 62 days 250 days 417† days (5.5† years)
  1 hour 125 days 500† days 2.3† years (11† years)
  2 hour 250 days 2.7† years (4.6† years) (22.5† years)
  6 hour 2.1† years (8.2† years) (13.8† years) (68† years)

† Battery lifetime may be shorter for some types.	  
‡ T-TEC RF only

NB. The above table is accurate for the on-board storage of the data logger. T-TEC 
RF data loggers set to ‘wrap-around’ that are regularly downloaded can create long, 
uninterrupted sequences that may contain millions of logs.

Logging intervals for T-TEC RF
The logging intervals for the T-TEC RF are very similar to the standard T-TEC 
with two additions (15 seconds and 15 minutes intervals). Time lengths in brackets 
are theoretical only as the battery within the data logger will limit the length of 
time. The total number of logs in a new RF logger has been very conservatively 
estimated at 100,000 logs. Due to data compression, the actual number of logs will 
be different for each recording data set.
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The Files - T-TEC RF Logger
The software saves the raw data in an internal database, saving the data to files 
with extension of ‘dta’ only when requested, when pressing ‘Download logger’ 
or by ‘View logs’. ‘DTA’ files are text files and can be read by Notepad. The data 
can also be exported from Graph Viewer to Comma-Separated-Values (CSV) for 
import into spreadsheet software. For more information on exporting data from 
Graph Viewer, please see the chapter on Graph Viewer on page 61.

Stop logging
The logger stops logging when the memory is full and the logger is set to stop at 
full memory, or when ‘Stop logger’ function is selected in the communications 
program.

The logger does not stop when it is communicating with the computer and the 
memory in the logger is read. All communications happen in the time between 
the logger recording the measurements. It can be set to log each second and still be 
read without disturbing the recording (logging).

A T-TEC RF logger needs to be stopped before being restarted. This is a security 
feature as existing data in the data logger will be lost when restarted. It is 
important to download the data from the data logger if that data is needed or 
wanted before restarting the data logger.

Battery
The battery is a ½aa lithium thionyl chloride 3.6v.

How long can the battery last?
This depends upon the type of logger, how often it measures and environmental 
factors. Frequent downloading of data uses battery power. Frequent downloading 
of files also uses battery power.

Expected battery life
T-TEC RF 6: 2 years
T-TEC RF 7: 1 year
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Current battery voltage
The battery voltage of a T-TEC RF is shown in the information panel for that data 
logger in TempReport.

Replacing batteries
If the batteries need replacement, it is recommended to change batteries before 
beginning a long measuring series. Please note that it may take up to three minutes  
before being able to contact the logger, after replacing a battery.

A logger set to ‘Wrap around’ will lose the correct start time if batteries are not 
replaced before system shut down and show a start time of 1st of January, 2001.

A new battery might be passivated. In that case it might look as a fully discharged 
battery and it should undergo depassivation prior to long stable use. The best way to 
do this is to insert the battery and refresh the logger several times, with about 30 sec 
intervals. During these refreshes, the battery symbol for that specific data logger will 
appear to refill. 

Access to the battery
Type 6 & 7
If the battery is replaced within 30 minutes of battery removal, the logger will 
continue logging. 

Remove the two screws in the sides and pull the two sections apart. When re-
assembling the case take great care that the instrument is completely dry and that 
the o-ring is properly placed in the groove (the data logger is waterproof due to the 
o-ring). Fasten the screws so the two parts just meet at the sides with the screws — 
do not over tighten.

The ½aa type is marked ‘+’ and ‘-’. Check with the markings on the battery holder 
to ensure the battery is mounted the right way. A battery inserted the wrong way 
round will be drained quickly but it will not damage the instrument.
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Settings
The following is a list of options found under the Settings dialog box.

General settings
Prevent computer from sleeping
Many computers are set to ‘sleep’ when not in use. This will interrupt updates, 
automatic downloads and even alarms. To ensure that this does not happen, please 
check this option and see page 12 for more information.

Start TempReport when Windows starts
This options allows the user to decide if TempReport should be started and open 
automatically when Windows is started.

Disable alarm popup message
This option prevents the notifcation pop up from the notification tray from 
appearing. This can be useful if you have no ability to close it.

Export downloaded files to separate folder
If you wish to save the files with the data to a specific location, including across 
your network.

Outgoing SMS
T-TEC RF data loggers can send alarm messages back to the software. The software 
has the ability to contact an external entity to send SMSes, either directly via ‘Use 
personal SMSGlobal account’, or via web service.

Personal SMSGlobal account or personal SMSExpress account
To use this option, sign up for an SMSGlobal account at SMSGlobal.com or sign 
up for an SMSExpress account at SMSExpress.com.  For SMSGlobal, once you have 
an account, you will need the Master API Key found under ‘API and Integrations’. 
The username found there goes in the ‘SMSGlobal API Key username’ field and 
the password goes in the ‘SMSGlobal API Key password’. 
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Use web service
This is also called cloud. This is in reference to wireless datalogger server software 
that can either be separately purchased and installed on your own server, or a 
subscription to access our server can be purchased. Then the information to 
log onto SMSGlobal is stored on the server software. This is not activated for 
Temperature Technology’s own cloud. 

Note
Sending an SMS on alarm is data logger specific and can be set for each data 
logger, under ‘Change alarms’ > ‘SMS alarm message’. If this option is checked, 
then a dialog will appear where phone numbers should be entered. SMSes will 
only be sent if recipient phone numbers are entered for an alarm. Please note that 
it is TempReport that sends the SMS alarm message, so the computer that hosts 
TempReport must be running and TempReport open.

Outgoing email server
The software can also send alarm messages via email if an active internet 
connection is available. To do so, the settings in this area must be filled in. There 
are two options to choose from and fill in:

Use web service
This is also called cloud. This is in reference to wireless datalogger server software 
that can either be separately purchased and installed on your own server, or a 
subscription to access our server which can be purchased. Then the information to 
send emails is stored with the server software.

Use custom SMTP server
This option allows the software to act as an email client (eg. Microsoft Outlook or 
Mozilla Thunderbird) to directly contact the email server to send an email. The 
best starting point may be your IT administrator.

SMTP host: the URI of the email server location (eg. smtp.domain.com)
SMTP port: the port number for sending of emails through that server, 
typically 587 or 465
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From email: the email address you would wish the email to appear from.
Use authentication: enable username and password to send to email server.
Use SSL: encrypt the username and password being sent to the email server.
Username/password: the username and password for the email account.

We recommend you seek out your friendly IT administrator for assistance.

Proxy Server Settings
Some organisations’ IT systems have proxy servers. These proxy server 
configuration details need to be entered into the software so that the software can 
communicate to external systems outside of the local system, for example, by SMS, 
email or cloud subscription. There are three possible options:

System default
The software finds the proxy server settings within the operating system (such as 
used for Internet Explorer) and uses them.

Custom proxy settings
The software will use these custom proxy settings to connect to the Internet. If 
this option is needed, there is a very high probability that somewhere nearby is an 
experienced IT administrator who can help you fill these settings in.

No proxy
The software will attempt to communicate directly to the Internet, without the aid 
of a proxy.

Our recommendations are first to try system default and if that does not work then 
ask your IT administrator for help with the settings.

Cloud subscription service (Web service)
The cloud subscription service is a storage and delivery mechanism. If you are 
using this service, data that you have downloaded from data loggers will be 
automatically sent to the cloud. The data on the cloud can be accessible to other 
users who also have installed TempReport and have a subscription key to the same 
cloud. If that access has been allowed, they will be sent the data the next time their 
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computer system is switched on and ready to download. All the data will also be 
kept online and accessible to those with the cloud subscription key and correct 
permissions. 

Cloud subscription service URI
Please input the URI (address) of the cloud subscription service.

Cloud subscription key
Please input the subscription key for the cloud, if a subscription to the 
Temperature Technology cloud has been purchased. A cloud subscription key can 
be purchased from Temperature Technology and renewed on an annual basis.

Backup and restore
In this tab, you can create backups of your logs and settings, either singly or 
together. The backup can be encrypted with a password. 

This can be used to share your data: the data in one installation can be backed up 
and restored in another installation. In this situation, it is sensible to share only 
the data and not the settings that contain your passwords. 

It can also be used as backup in case of computer failure. In this case, you should 
store the backups on a different medium than your computer and settings should 
be included in the backups. It would be wise to encrypt any backup that contains 
settings with a password. Please memorise or store that password in a safe place. 

Local passwords
All passwords (minus the backup passwords) are collected here. The passwords 
themselves are not visible but you can see information about which device it 
applies to via the serial number, the device’s type (either data logger or gateway) 
and a description of the password. 

In this screen you can delete any or all passwords. Note that you can also delete 
any Master Passwords you have set, preventing the software from communicating 
to any data loggers you have secured with that password. So delete with caution.
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New passwords sent by others for their data loggers can also be added into this 
area by clicking on ‘Add new’. 

This is also the location where you can add keys sent by others. Keys are generated 
in ‘Logger security’.

Export Settings - MQTT
TempReport currently supports MQTT v3.11. The software acts as a client sending 
data to a broker, and in future, the T-TEC Gateway will also be a client. Currently, 
in TempReport, under Settings, there is a tab called ‘MQTT’. That is where the 
address of the broker needs to be entered, the client ID and the topic to send to.

Note: there are certain reserved characters that must not be used in topic names. 
These characters are ‘#’ and ‘+’ as they have specific meaning within the MQTT 
specification.

The broker
The broker can be something already up and running as a test service such as 
HiveMQ’s MQTT Dashboard (http://www.mqtt-dashboard.com/). It can be 
one that is downloaded and stored on a private host, such as Mosquitto (an 
open source MQTT broker -- https://mosquitto.org/). All sorts of other more 
fancy brokers exist such as Apache Active MQ (http://activemq.apache.org/) or 
RabbitMQ (https://www.rabbitmq.com/) that can receive messages in various 
formats and transmit them either in the same or different format.

Clients can be anything, including browsers that have support for the Websockets 
API (W3C standard) which most modern browsers do.

The data
Currently, two types of messages are implemented within TempReport: alarm and 
data updates. Data updates are used within TempReport to show the last updated 
temperature measurement on the main screen. When TempReport receives these 
messages from the Gateway, it sends them on to the locations and topics as entered 
in the ‘MQTT’ tab under ‘Settings’.
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Note: the topic listed in this tab is used as ‘root’ level. Alarms are sent to topic: root 
level/alarm/logger/sensor and updates are sent to root level/regular/logger/sensor.

Alarms - topic and message
For an example, ‘Smith Corporation’ will be used as an example of the topic listed 
in TempReport under ‘Setting’ > ‘MQTT’. Smith Corporation owns T-TEC RF 
loggers with serial numbers 71, 72, 73, 74 and 75. So if logger T-TEC 7 RF – 3F 
(a wireless T-TEC logger with display and two external sensors) with the serial 
number 73 raises alarm 2 on sensor number 2, once it reaches the software, the 
alarm will be propagated to the listed MQTT server with the topic:

Smith Corporation/alarm/73/2.

The message that is sent to that topic is in plain text and is in UTF-8, written in 
JSON format. The time is in UNIX time. The message looks like:

{serial: 19, time: 1465885753, sensor: 2, alarm: 2}

Updates
For regular data updates, the topic is root level/regular/logger/sensor. So updates 
for data logger number 73 from Smith Corporation appear like:

Smith Corporation/regular/73/1

Smith Corporation/regular/73/2

Note: each sensor has its own topic and a message is sent to each topic only about 
the individual sensor. The message that is sent to that topic is in plain text and is 
in UTF-8, written in JSON format. The time is in UNIX time. The message looks 
like:

{serial:128, time:1465883753, sensor:2, value:19.540}
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Security
MQTT can have both security through TLS and identity, authentication and 
authorisation (IBM, 2016b) although as of July 2016, TempReport doesn’t currently 
support these features.

Quality of Service
Quality of Service is important part of MQTT. It helps to overcome unreliable 
networks and describes how the communication should be ensured across those 
networks (HiveMQ, 2016b).

There are three levels of Quality of Service:

1.	 At most once
2.	 At least once
3.	 Exactly once

The QoS TempReport uses when sending messages is QOS_LEVEL_EXACTLY_
ONCE. This means that each message is sent once, storing the message until an 
acknowledgement is received.

Retain
MQTT brokers can retain a message: they can save a message until it is replaced 
by a new message. This means a new subscriber will receive the last message upon 
subscription. This is currently set to false by default.

Last will and testament
This is set in the connection settings, and is currently set to false. A last will and 
testament would send a specific message if the source of the data (in this case, 
TempReport) fails to send data within a specified time. This means that if data is 
not sent within, for example, 18 hours, a special pre-prepared message will be sent 
to subscribed clients.
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Clean session and keep alive
TempReport currently keeps a clean session (persistence) and keep alive is set to 60 
seconds.

This means TempReport will send a message at least every 60 seconds. If the 
MQTT broker does not receive a message at least once per that interval, then the 
broker will assume that the connection is lost.

How to use MQTT
MQTT was introduced to TempReport to help bring the data out of TempReport, 
and into other systems, eg. Building Management Systems.

The first port of call would be the specifications for MQTT 3.11 http://docs.oasis-
open.org/mqtt/mqtt/v3.1.1/mqtt-v3.1.1.html

There are some tutorials online that can assist with building software with MQTT:

1.	 Thingtastic.com has one for MQTT and Websockets: http://www.thingtastic.
com/tutorial/mqtt-with-websockets-and-html/

2.	 Paho MQTT has an example for C# (M2MQTT): https://github.com/eclipse/
paho.mqtt.m2mqtt

There are many libraries, and it wouldn’t be possible or reasonable to attempt 
to make an exhaustive list. Temperature Technology does have demonstration 
MQTT code. Please enquire.
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Export Settings - LAN Export
TempReport can also export the data to a location on the Local Area Network 
(LAN). To set this up, it needs to be enabled and given a computer destination, 
either a name or an IP address and a port. Alternatively, it can be broadcast.

Gateway management
TempReport will detect one USB Gateway attached directly to a computer.  All 
other Gateways attached to the same computer will not be recognised by the 
software.  This dialog is for managing Gateways attached to other computers on 
the same Local Area Network (LAN).

To add another Gateway, click the button that says ‘Add’. To change a setting for 
a Gateway, highlight it in the list and press ‘Modify’. Both will produce the same 
dialog.

Enter Gateway MAC address
Please enter the MAC address of the Gateway. This can be either the MAC address 
of the Gateway itself, which can be found printed on the casing of the Gateway, 
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or the MAC address of the computer a Gateway is connected to, where the LAN 
service is running.

Enter Gateway name
Please give the Gateway a human-understandable name. For instance, if it is the 
only Gateway that will be installed in Building 7, it may make sense to refer to it as 
Building 7.

Gateway IP address: Autodetect
This setting will look for MAC and IP address broadcasts from Gateways on the 
LAN, and see if any match the one whose details are entered into this form.

Gateway IP address: Static IP 
This setting is meant to speak directly to Gateways across the Internet at specific 
IP locations. This means the network administrator has assigned a specific IP for 
that Gateway.

Viewing the Graph
Once a graph is displayed in Graph Viewer, please turn to the chapter on ‘Graph 
Viewer’ for instructions on use.
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T-TEC logger
If your logger looks like below, then read this section. Otherwise, please find the 
chapter that has a picture that looks like your data logger, listed on page 9.
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Program configuration
All Communications programs must be configured so the program can know 
which type logger is used and which port the data logger is connected to on the 
computer. Configuration is most easily done the first time the program is opened.

To start the software, click on the icon for T-TEC Logger

 T-TEC Logger is the communications program for the T-TEC logger.

Configuration for a T-TEC data logger
Connect both a T-TEC data logger and a USB cable, and open the T-TEC data 
logger communications program.

The program will now scan the ports on the computer and try to detect which 
adaptor is connected to which port. 

The result will be shown 
in the window ‘Port 
Configuration’. If one of 
the four small boxes to 
the left is ticked, then the 
program has found the 
adaptor and is configured.

Then un-tick the 
small box at top: ‘Auto 
configuration at start’ to avoid having the program search for settings each time 
it is opened.

Click ‘Save’. The program is now ready to use.

If there are no ticks in any of the four boxes at the left then the auto detect 
procedure could not find the interface adaptor. Please see Troubleshooting in 
the help file for the T-TEC program for possible solutions. Press ‘F1’ within the 
program to bring up the help file.
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This section is the same as ‘express help’ in the installed manual. It will show how 
to start the logger and read the logger. Following the tutorial in the on-line manual 
is recommended.

Communication with the data logger
The T-TEC interface cable must be connected to a USB port which has been 
configured as described.

Now connect the data logger to the cable. This may be done at any time unless the 
red stop sign is displayed in the program.

This sign indicates that active transmission between the computer and the data 
logger is taking place. It is very important to not connect or 
disconnect the data logger when this sign is shown on the screen. 
Transmission only takes a few seconds.

To read the T-TEC logger
In the main window of the graphics program (T-TEC Graph Viewer)

A.	 Select ‘Logger’ and ‘To T-TEC logger’. The T-TEC Communications 
screen appears similar to the image below: 

B.	 Connect the logger to the cable. 
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C.	 Click on the ‘Menu’ icon to pull down the menu.
D.	 Click ‘Check cable’. A message will appear at the bottom of the screen. 

If that message is ‘Cable detected’, move on to step E. If not, see 
troubleshooting in the help file in the software, by pressing ‘F1’ . 

E.	 Click ‘Check Logger’. The stop sign will show for a short while. The 
identity information held in the data logger will be displayed as well as 
the current temperature of the T-TEC logger. If your logger has a remote 
probe, you will get a window up where you are asked to choose a sensor 
file with the suffix ‘.sda’. For standar sensors, choose ‘sen1.sda’.

F.	 Click menu again and click ‘Autoload’ to download the file of times	
and measurements from the datalogger memory.  
If ‘Download data’ is used, the file will be saved. To view the file in 
‘Graph Viewer’, click ‘File’ > ‘Load curve’ > and find the file manually.
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G.	 The data from the logger must be saved to a file first. A file window will 
appear. It will show a filename constructed of the year, the month, the 
date and the logger number. The file name can be changed by the user. 
Click ‘Save’ when ready. 

H.	 The data from the logger will now be converted and shown on the graph 
as a curve.
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To start the logger
Points A. to E. as in previous section, then:

I.	 	Click ‘Menu’ and ‘Start Logger’. The ‘Start Logger’ window appears.

J.	 In ‘Start Logger’ there is a calculator. If the user types in the expected 
maximum number of measurements (depending on logger type) the 
calculator will show how long a time a data logger can log at various 
time intervals. Data loggers with data compression can contain more 
measurements if the measurements are very similar or only vary slowly.

K.	 In this window set logging interval, start time and wrap around / 
stop	 when memory is full. Under comments you may type specific 
information for the new file the logger is going to log. (Tasks, names and 
places may be useful for identification later).

L.	 Current time: The logger reads the internal clock of the computer at the 
time of start of the data logger. To get precise timing in real time, the 
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computer’s clock should be adjusted at regular intervals - eg., bi-monthly,  
depending on the accuracy of the clock.

M.	 	Start time: The logger may be started with a delayed start. Using the 
arrows a later time for the start may be specified up to a delay of 1 week 
from start.

N.	 Alarms may be set as either minimum or maximum alarms. 
Time: Grace period before alarm is triggered must be minimum 1 
minute. 

O.	 Alarm reset: Setting the daily time that the alarm(s) and grace period(s) 
reset. Optional.

P.	 Click ‘Start Logger’ and ‘Yes’ to start the logger. The logger beeps when 
it receives the new setting.

Q.	 Wait until the stop sign disappears and exit this screen. The data logger 
is now logging as instructed. You can click ‘Info’ to check the new 
settings in the data logger.

R.	 ‘Save Settings’ is useful if you have many data loggers to start up with 
almost identical settings. Once clicked, the start screen will come up 
with the same settings preloaded each time.

S.	 If you would like a hard copy of the set-up details, pull down the ‘Menu’ 
again and click on ‘Print certificate’. The details will now appear in your 
text editor (eg. Notepad) and may now be printed. 

T.	 	When the stop sign disappears, disconnect the data logger from the 
cable. It is either now started or in delay start mode.

For loggers with a display, once started under delay start, it will display a target 
sign. Once the data logger starts to record, the target sign will blink.

Tutorial
The ‘tutorial’ in the on-line manual will take you through some of the many 
facilities this program offers. To access the Tutorial select ‘Help’ from the top bar 
in the graphics screen, then ‘Contents’ and ‘Tutorial’.
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The help-text and the tutorial can stay on top of the T-TEC program so it is 
readable when working with the program. The tutorial will take about thirty 
minutes to an hour and is strongly recommended for new users.

The tutorial and any other topic in the ‘Help/Manual’ can be printed out by 
clicking the printer icon.

The files
When the computer reads the memory in the T-TEC logger, it creates a small 
2 to 32 kB file with the extension ‘DXD’. This is a complete copy of the data in 
the logger’s memory and is in compressed format. To access the data, it must be 
converted to a more readable format (‘DTA’) and the T-TEC program has facilities 
for this with the ‘Convert’ procedures in the ‘Logger’ menu.

For convenience, the ‘Autoload’ procedure will automatically convert new DXD 
files and create a file with the same name as the DXD file but with the extension 
‘.DTA’.

Both DXD files and DTA files are saved on the computer’s hard disk and remain 
until they are removed by the user.

Files with extension ‘.DTA’ are much larger and may be up to 700 kB long. The 
program stores both file types from a T-TEC logger. It is easy for a user to make 
a backup copy of the DXD files. DTA data files can always be re-created from the 
‘DXD’ file with the ‘Convert’ procedures. 

Data Compression
T-TEC loggers use data compression for the data in the memory of the logger. The 
memory can then contain a greater number of measurements. The more constant 
the measurements are, the larger number of measurements the logger can keep. 
This is the reason we cannot give a fixed number of data a logger can contain. The 
exception to this are the C-loggers which do not work with data compression and 
can only store a fixed number of measurements (3,100 sets for older loggers and 
10,600 sets for newer loggers) and F-loggers which can store a maximum of 21,000 
measurements.
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Data logger with external sensor
Different thermistor sensors will give different measuring ranges for the T-TEC 
data loggers. For example, a standard sensor (Type 1) will measure from -40 to +85 
degrees Celsius and a T-TEC type 2 sensor from -100 to +20 °C.

If the datalogger has a fixed or Pt100 sensor, the program will detect the type of 
sensor. If the logger uses an external thermistor sensor, then the sensor must be 
specified in the program.

See ‘Choose Sensor’ in the help file. 

Sensor files (.SDA files)
The sensor is defined with values kept in a sensor file, e.g., 

sen1.sda for the standard temperature sensor (T1) range -40 +85°C
sen2.sda for the low temperature sensor (T2) -100 +20°C
sen6.sda for the high temperature sensor (T6) +20 +160°C

You can use your own thermistors if you so desire and create a sensor definition 
file yourself - see ‘Help’ in the program under ‘Advanced Topics’ > ‘Thermistor 
sensors’.

Defective Sensors
A data logger with a short circuited sensor will record a very high temperature 
and a data logger with an open circuit sensor will record -273 °C. Please return to 
manufacturer for repairs.

Alarms
T-TEC Type 6 and 7 loggers (except loggers for humidity) contain an alarm 
function. Two alarm temperatures may be set when the logger is started, either as 
a maximum (alarm if temperature exceeds a set limit) or as minimum (alarm if 
the temperature falls below a set limit), and an individual delay time may be set for 
each alarm (grace period).
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If an alarm is triggered, a T-TEC 6 data logger will indicate this with ‘beeps’: one 
beep if alarm1 has been triggered, two beeps if alarm2 has been triggered and 
three beeps if both alarms have been triggered. A T-TEC 7 data logger will show 
‘A1’ if alarm1 has been triggered, ‘A2’ if alarm 2 has been triggered and ‘A12’ if 
both alarms have been triggered.

The beeping may be stopped by connecting the logger to the PC and choosing 
‘Stop Alarm’ in the menu in the ‘T-TEC Logger’ software.

Relay output
If you have a T-TEC data logger with relay output, please refer to the instruction 
note supplied with the data logger for the specific function. 

A 3-wire cable for relay connection is provided. The relay connects the black and 
blue wires in reset and the black and brown wires in alarm.

Maximum load (resistive) for the relay: 1A 30V DC, 0.5A 125V AC.

Number of measurements for a logger
The data sheets show the expected number for a specific logger type.
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Logging duration at different intervals 
Interval 3,000 logs 12,000 logs 20,000 logs 100,000 logs‡

 1 sec 50 min 3.3 hours 5.6 hours 27 hours
 2 sec 1.7 hour 6.7 hours 11 hours 2 days
 5 sec 4.2 hours 17 hours 28 hours 5.5 days
 10 sec 8.3 hours 33 hours 2.3 days 11.5 days
 30 sec 25 hours 4.2 days 6.9 days 34 days
 1 min 2.1 days 8.3 days 14 days 69 days
 2 min 4.5 days 17 days 28 days 138 days
 5 min 10 days 42 days 69 days 347 days
 10 min 21 days 83 days 169 days 1.9 years
 30 min 62 days 250 days 417 days (5.5 years)
  1 hour 125 days 500 days 2.3 years (11 years)
  2 hour 250 days 2.7 years (4.6 years) (22.5 years)
  6 hour 2.1 years (8.2† years) (68 years)

† Battery lifetime may be shorter for some types.	

Wrap around
If the data logger is set to ‘Wrap around’ and the memory becomes full, then the 
oldest data stored is replaced by the newest. The oldest data is lost. This may be 
useful to you if only the most recent data is of interest.

Stop logging
The logger stops logging when the memory is full and the logger is set to stop 
at full memory, or when ‘Menu’ > ‘Stop logger’ function is selected in the 
communications program.

The logger does not stop when it is connected to the computer and/or the memory 
in the logger is read. All communications happens in between the logger recording 
measurements. It can be set to log each second and still be read without disturbing 
the recording (logging).

It is not necessary to stop logging when a T-TEC logger is read or restarted.



ttT-TEC User manual

50

Battery
How long can the battery last?
This depends upon the type of logger, how often it measures and environmental 
factors.

Expected battery life
T-TEC 6: 3.5 to 4 years
T-TEC 7: 2+ years.

Current battery voltage
The ‘Check Logger’ function in the communications program will display the 
actual battery voltage.

T-TEC 501 series uses two batteries, 3v lithium manganese batteries type cr2450.  
Type 6 and 7 use one battery, ½ aa 3.6v lithium thionyl. TempTec 816 uses one 
battery, aa 3.6v Lithium 

Replacing batteries
If the batteries need replacement, it is recommended to change batteries before 
beginning a long measuring series. 

A change of batteries in a logger containing data may result in loss of some of the 
newest data but the majority may be read after a change of batteries. 

Note
A logger set to ‘Wrap around’ will lose the correct start time when reset is pressed 
or batteries are replaced and show a start time of 1st of January, 1970.

Access to the batteries
Type 6 & 7
Remove the two screws in the sides and pull the two sections apart. The ½aa type 
is marked ‘+’ and ‘-’. Check with the markings on the battery holder to secure the 
battery is mounted the right way. A battery inserted the wrong way round will be 
drained quickly but it will not damage the instrument.
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When assembling the case: take great care that the instrument is completely dry 
and that the o-ring is properly placed in the groove. Fasten the screws so the two 
parts just meet at the sides with the screws — do not over tighten.

Logger reset
When a new battery is inserted, the logger responds with 3 beeps. If you do not 
hear the beeps, it is necessary to press the switch marked reset inside the logger. 
The logger then resets, checks its batteries and makes three beeps or blinks if all is 
OK. 

More recent data loggers have 2 reset pins instead of the switch. A reset is done by 
removing the battery and then shorting the two pins. Reset — and three beeps — 
will then be executed. This also will happen when the battery is mounted.

Viewing the Graph
Once a graph is displayed in Graph Viewer, please turn to the chapter on ‘Graph 
Viewer’ for instructions on use.
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iButton logger
If your logger looks like below, then read this section. Otherwise, please find the 
chapter that has a picture that looks like your data logger, listed on page 9.

These dataloggers connect to the computer through a USB port via a USB Adaptor 
connected to a Blue Dot Reader.
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tt

To start the program
To start the program, double click on the icon for ‘Thermochron logger’.

Thermochron Logger is the communications program for iButton loggers.
Note: iButton data logger communications programs can be accessed from 
the T-TECW program and this may be the most convenient way.

To open the iButton Communications software, either double click the icon on 
the desktop, or go to ‘Start’ > ‘All Programs’ > ‘Temperature Technology’ > 
‘Thermochron Logger’ or go to ‘Graph Viewer’ > ‘Logger’ > ‘To Thermochron’. 

The program will automatically detect the presence of the adaptor and 
attached iButton data logger. If this does not occur, please see the section on 
‘Troubleshooting’ or contact Temperature Technology for technical support.

Communication with the data logger
The Blue Dot Reader must be connected to an adaptor and USB port before 
communication.

In case of errors
If needed, simply re-install the program(s). There is no need to un-install anything 
before re-installing.

The files
Data from the iButton will be converted to a DTA file directly. This is true for both 
the iButton or TempTec Reader Communications software. Files from TempTecR 
Communication software must be saved by the user.

T-TEC User manual
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To read the data logger
A.	 The iButton Communications screen appears similar to: 

B.	 Select the iButton you wish to operate from the list by clicking on it 
(in the list under the ‘Exit’ button). It should appear highlighted once 
selected.

C.	 Click ‘Check Logger’. The identity information held in the data logger 
will be displayed.

D.	 Click ‘Autoload’ to download the file of times and measurements held in 
the datalogger.

T-TEC User manual
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E.	 The data from the logger must be saved to a file before opening and a 
file window will appear. It will show a filename constructed of the year, 
the month, the date and the logger number. This name may be used or 
another name chosen with no blanks and no special characters. Click 
‘Save’ when ready. 

F.	 The data from the logger will now be converted and shown in ‘Graph 
Viewer’, as a curve.

To start the data logger
A.	 Click the button ‘Start logger’. A dialog will appear 

asking if you wish to start this logger with the 
same settings it was started with previously. Enter 
either yes or no. The default settings for ‘No’ are the 
settings entered for the last iButton started on 
this computer, which may or may not be this 
particular data logger.

B.	 In this window set logging interval, optional 
delay start with start time, wrap around / stop 
when memory is full and temperature alarms. 
In the comment fields you may type (optional) 
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specific information for the new file the logger will log (tasks, names and 
places may be useful for identification later).

C.	 The logger reads the internal clock of the computer at the time of start of 
logger.

D.	 	Delay start: the logger may be started with delayed start. Click on the 
down arrow and with the date selector, a later time for the start may be 
specified but not more than 44 days from the current time.

E.	 DS1921 iButtons must have alarms set and other iButton types may have 
optional alarms. A list of alarms are accessed via ‘Show alarms’ on the 
main screen.

F.	 Click ‘Start Logger’ and ‘Yes’ to start the logger. 
G.	 The program will confirm the logger has been started. The new settings 

will be displayed.
H.	 The software will store these new settings and may display them next 

time a data logger is set up.
I.	 If you would like hard copy of the set-up details, click on ‘Print 

certificate’. The details will appear in your default text editor, from 
where it can be printed. 

The manual is pre-installed. Click ‘Help’ or press ‘F1’ in the menu bar to open it. 
The help-text can stay on top of the program so it is readable when working with 
the program and any topic in the ‘Help/Manual’ can be printed out by clicking the 
printer icon.

Viewing the Graph
Once a graph is displayed in Graph Viewer, please turn to the chapter on Graph 
Viewer for instructions on use.

The files
When the computer downloads the memory in the iButton data logger, it creates 
a file with the extension ‘DTA’. This is a readable text format of the data in the 
logger’s memory. DTA files are saved on the computer’s hard disk and remain 
until they are removed by the user. DTA files are used for creating files suitable for 
export to spreadsheet programs.
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Logging intervals for iButtons
A ds1921 Thermochron can store 2048 measurements. ds1922s can store either 
4,096 or 8,192 measurements, depending on resolution. Similarly, ds1923s can 
store either 2,048 or 4,096 measurement pairs (temperature and humidity).

Battery
How long can the battery last?
This depends upon the type of logger, how often it measures and environmental 
factors.

Expected battery life
Batteries in iButtons are not replaceable.
ds1921: 5-10 years, depending on the use and the temperatures:

In a freezer 2-3 years
In a refrigerator 5-6 years
In room temperatures 6-8 years.

ds1922 and ds1923: 2 days to 10 years.

VERY IMPORTANT NOTE
The ds1922 and ds1923 will have a very short life period (2 days) if set to log at fast 
intervals (less than 60 seconds) and at a high resolution. We recommend that low 
resolution and longer intervals are chosen.

To stop the logger
Stops the data logger measuring or storing any more data. Data stored in the data 
logger can be read later.

Note 
If the logger is started in ‘wrap around’ mode, it will start writing new samples 
over the oldest logs. If the logger is started with ‘stop when memory is full’, the 
logger will stop writing to the memory and keep the file. However, the logger will 
continue to sample temperature and update internal registries accordingly. The 
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‘Stop Logger’ function will save battery and is recommended if the logger will not 
be used for some time.

Alarms
Although the small iButtons are not able to give out a signal when an alarm point 
is triggered, it does record the start time and duration of each event, which can be 
seen as a list when ‘Show alarms’ is clicked.
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TempTec 816
If your logger looks like below, then read this section. Otherwise, please find the 
chapter that has a picture that looks like your data logger, listed on page 9.

USB

Power

Graph Sensor Long press
Min/max reset

Long press
Mute alarm

ttTempTec 816

The older TempTec 816 (pre 2021) is a T-TEC data logger. Please follow the 
instructions for the T-TEC data logger for this model. Special comments for the 
battery are found on the next page.

The newer TempTec 816 (2021 and onwards,) is a wireless T-TEC RF version. Please 
follow the instructions for the T-TEC RF loggers for this model. 
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Battery
The battery is AA 3.6V, and will last at least one year, depending on how often it 
measures and environmental factors.

Expected battery life
The battery should be changed once a year.

Current battery voltage
The ‘Check Logger’ function in the communications program will display the 
actual battery voltage.

Replacing the battery
If the batteries need replacement, it is recommended to change batteries before a 
long measuring series. 

Access to the battery
Battery cover is found at the side of the casing. The + side of the battery must face 
the battery cover.
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Graph Viewer
To start the program
Double click the icon for the required program: 

T-TECW Graph Viewer is the graphic program for handling of data from 
the data loggers and the TempTec Reader.

Open a file
To open a file, go to ‘File’ > ‘Load Curve’, or if you have downloaded the raw data 
from a standard T-TEC data logger, ‘File’ > ‘Autoload select’. Files are downloaded 
and constructed within their respective Communications programs.

Printing and export of files
To get a list of measurements and times go 
to: ‘File’ > ‘List File’ This creates a list which 
includes all the data from the file. The data 
will appear on the screen using ‘Notepad’, 
‘Write’ or ‘Wordpad’, depending on the 
operating system.

To limit the amount of data it is 
recommended to first zoom in on the 
important part of the file and then use ‘List 
curve’.

‘File’ > ‘List Curve’ makes a list where only 
data seen on the screen are included. 

The lists can be printed or saved to a file for later printing. The filename of a list 
has the same filename as the datafile with the extension .txt instead of .DTA. This 
file may be opened by spreadsheet programs. You will be given the option of where 
to save the .txt file.
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Please be aware that the graphs for the new T-TEC RF loggers can contain 
many datapoints and thus may result in a large exported file. Please check the 
requirements of your spreadsheet software to ensure it can handle the data size.

Saving the graph for inclusion in reports or email
For inclusion in reports or emails you may want to design the looks of the graph 
using ‘zoom’, ‘add comments’, ‘add y-line’ etc. 

To save the graph as it looks on the screen in a graphic format that may be inserted 
into word processor programs or sent as attachments to emails, go to: 

‘File’ > ‘Export as .PNG’ 

You will be given the option of where to save the file. 

PNG stands for Portable Network Graphic and is an ISO standard. It is similar to 
a normal image and can be used in email, web browsers, word processors, and so 
forth, just like any other image.

Introduction
The following examples show measurements from 2 data loggers and how the 
graphic program may be used to extract relevant information from the data.

Example 1 shows how to use the ‘zoom’ and the ‘plot’ function to set the graph as 
required.	

Example 2 is a simple measurement on a domestic freezer. It shows the use of two 
loggers, one with internal sensor and one with fixed external sensor. This example 
is based on the two files (Exam1a and Exam1b) supplied with the distribution disk.

Example 3 shows the result from a shipment of meat from Adelaide to Geneva in 
Switzerland. Two logger are used. One logger measures the temperature of the 
goods, the other measures ambient temperatures see why the temperatures in the 
goods change during shipment.
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Example 4 is based on measurements in our store room for a period of eight 
months and shows use of ‘Smooth curve’ or moving average.

‘Zoom’ & ‘Plot’
‘View’ > ‘Zoom’ can ‘magnify’ a part of the graph. 

Select ‘Zoom’. Move the 
cursor to a point on the 
graph that should be the 
left bottom corner of 
the zoomed graph, press 
the left mouse button 
and hold it down. Drag 
the mouse until the box 
contains the part to be 
magnified. Then release 
the mouse button. The 
area of the graph inside 
the box is now magnified 
and it is easier to see the exact degrees and measurement times.
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Plot
This function is used to design the graph 
for printing. The program auto-scales 
the graph to fit the curve/s that are 
currently on the screen. 

For comparison between printed curves, 
it may be preferable to have all the 
graphs using the same scales. 

To do so, we first clear the graph of data, 
noting that the data is still stored within 
the software. We will bring the data back 
up later.

Click ‘Plot’, then ‘Clear’.

Click ‘Limits’. In ‘Limits’, as shown on the right, you can set the scale (in the 
example minimum 0 and maximum 30°C) and the time range you want displayed 
on the graph. 

Click ‘Set’, and you are returned to the ‘Plot’ menu. From here, click ‘Scale X’ and 
‘Scale Y’ to display the X and Y graph axes. Click ‘Plot Curve’ and individually select 
each curve you would like displayed on the graph. The graph will appear as you have 
designed it.
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Measurements from a freezer

Figure 2.1
Two loggers were used used: B1061 has a fixed external sensor and B1141 an 
internal sensor. Logger B1141 is started approximately 2 hours after logger B1061. 
Both loggers are set to measure once each minute.

After both loggers were started, they were placed side-by-side inside a domestic 
freezer and left there overnight. When the loggers were read the next day, the files 
were called Exam1A and Exam1B.

The two files are included in the distribution disk and may be used to try some of 
the features of the program.

The graph in figure 2.1 shows the raw data — the graph you will get when the files 
are first loaded to the graph. To get these curves on to your screen, click ‘File’ > 
‘Load Curve’ for Exam1A.dta and ‘File’ > ‘Autoload first 8’ to get the Exam1B file 
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onto the screen. Exam1A is converted on the distribution disk, Exam1B is not (see 
the online manual (press ‘F1’) regarding file types).

Understanding the graph
The graph shows the temperatures to the left and the time for measurements along 
the bottom. 

At the top of the graph there is a line with the words ‘File’, ‘Logger’, and so on, 
which are pull-down menus. A click on any of these words will give access to 
groups of functions.

Below this line is a field to the left divided in two parts: the top part shows the 
software version and the second is blank.

To the right is another field which shows the file names and data logger 
identifications for the curves on the screen.

In case of one curve only, this field will show all details from the logger with time 
interval, number of points, etc. With more than one curve on the screen, the 
information is reduced as shown in Figure 2.1.

Full information about the curves can be found under ‘Info’ in the top bar.

The reduced information includes a small colour-coded rectangle with either T for 
temperature or H for humidity, next to the serial name, number and date of each 
curve.

A format with the time scale in seconds, minutes or hours, from the start of the 
logger is very useful if measurements taken at different times are to be compared, 
eg. before and after a repair, or summer compared to winter. 
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Figure 2.2

To get calendar time (month, day, hour, etc) click on ‘View’ in top bar and then 
‘Time Scales ’ > ‘Calendar’. The graphs may not overlap in time.

The graph will change to look like Figure 2.2. The bottom of the top left field will 
now show the time for the start of the graph.

The numbers just under the graph show the time of the day in 24-hour format. The 
line below shows the day in the month as shown by the legend to the left.

The time intervals on the graph will be set so the graph can show all data from the 
data logger. It could be months, days, minutes or seconds.

When the graph is changed to calendar time then six o’clock for one logger is also 
six o’clock for another logger. The loggers will therefore be synchronised in time 
and more loggers can work together as a multichannel logger.
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As shown on figure 2.2, it is not necessary that the loggers start at the same time. 
One logger in this example was started several hours after the first. The software 
in the computer is able to synchronise the graphs as long as the measurements 
overlap in time.

Up to 8 curves may be shown together on the graph.

‘Analysis’ > ‘Statistics’
This will drop a window with minimum, average and maximum values for the 
part of the curves that can be seen on the graph. Measurement values not shown 
on the graph are not included in the calculation.

Here, the average shows to be very close for the two loggers and the difference in 
minimum and maximum values shows the difference in time constants for the 
two loggers. 

Figure 2.3 Screen shot of ‘Statistics’
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In figure 2.3 is a dialog box with various statistics. These statistics are for the parts 
of the curves currently displayed on the graph. One of the fields is ‘MKT’. MKT 
stands for ‘Mean Kinetic Temperature’, which is a weighted average, used in the 
pharamceutical industry, See the online help for more information.

In figure 2.4, the curve Exam1B has been removed to get a simpler picture. (‘File’ 
> ‘Close Curve’), the curve has been zoomed again and ‘Analysis’ > ‘Load Factor’ 
chosen.

The curve is now overlaid with another curve made of straight lines which 
averages the cycles. As described in the on-line help (Press ‘F1’ and use key word 
‘Load Factor’), the overlaid curve can be manipulated to follow the original curve.

Figure 2.4
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In figure 2.4, the overlaid curve is now modified to follow the cycle from 3 to 6.30 
am and ‘Details’ is used to get further information about the behaviour of the 
freezer.

The period time (from top to top) is 3.6 hours and the amplitude (difference 
between warmest and coldest point) is 7.4 °C. If the compressor starts when the 
temperature stops rising and stops when the temperature stops falling, then the 
compressor has been on for 23% (21.63+1.35) of the time and off for 77% of the 
time. 
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Example 3: A shipment of chilled meat 

Figure 3.1 

<-------------- Shipment --------------->|<---------- Return of loggers by mail --------->

Meat packed into an insulated aircraft container. Two loggers were used. One 
outside on a box inside insulation (B236) and another outside insulation (B237). 
Figure 3.1 displays raw data as read from logger after return in a jiffy bag. Time 
scale is seconds from the start of loggers.
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Figure 3.2

A.	 ‘View’ > ‘Time Scales’ > ‘Calendar’ to change to real time with days and 
hours.

B.	 ‘View’ > ‘Zoom’ to cut off information from the return mail.
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Figure 3.3

C.	 ‘View’ > ‘Add Y line’, 4 °C
D.	  ‘View’ > ‘Add Comments’ for locations. (matched with data from 

airlines.)
The shipment leaves Adelaide for Melbourne (temperature falls during flight) and 
the cargo is left on the tarmac in Melbourne for approximately 10 hours. The next 
flight goes to Singapore where it is quickly loaded into a plane on its way to Zurich, 
where it is cold and wintery. The meat is loaded onto a refrigerated truck in a 
warehouse and driven to Geneva. 
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Example 4: Store room temperatures

Figure 4.1

Temperatures in store room over eight months. ‘Time Scale’ set to ‘Calendar’ time, 
otherwise this is raw data.
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Figure 4.2

A.	 ‘Options’ > ‘Graph Colours’ used to change curve to light grey.
B.	 ‘View’ > ‘Smooth’ used to show moving average (or trend). Smooth 

factor set to 24, which with 30 minutes between measurements gives a 
24-hour moving average.
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Figure 4.3

As Figure Example 4.2 but ‘Smooth’ factor set to 168 to give a weekly moving 
average.


